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What is Media Writer?

Media Writer is a program that physicians can use to burn studies onto CDs/DVDs or USB flash drives, and
upload studies to image exchange services. This makes studies available to other physicians through Open
Image Exchange, and to patients who can view their studies on a PC. With the Media Writer System
CD/DVD burner, physicians can also design and print labels on the CDs and DVDs.

What is a DICOM source?

A DICOM source is a DICOM worklist server, archive, or other device that can respond to patient queries. To
query and retrieve studies in Media Writer, you must add at least one DICOM source. Consult with your
PACS administrator for the DICOM sources available at your institution.

Add a DICOM source

To add a DICOM source, complete the following steps.

On the Settings menu, click DICOM.
2. Inthe DICOM Settings dialog box, under DICOM Sources, click Add.
3. Inthe Add/Edit Source dialog box, add the following information.

« Name. Type a name for the source.

« AE Title. Type the AE title of the source.

« IP Address. Type the IP address of the source.

« Port. Type or select the port number of the source.

4. If yoursourceis an Intelerad PACS, select the Q/R on Default Auto Burn check box and configure
the PACS to send images to the Media Writer auto burn port.

5. Click OK.

Test a connection to a source
To test whether Media Writer can query a source, complete the following steps.

1. Onthe Settings menu, click DICOM.
2. Inthe DICOM Settings dialog box, under DICOM Sources, click a source.
3. Click Test.

The Test Results dialog box appears, indicating whether the test passed or failed.
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Create compressed copies of study images

You can burn JPEG2000 Lossy—compressed copies of study images in addition to the original images. Gear
View Basic loads compressed images for patients to view by default, and physicians can load the original
high-resolution images for diagnostic viewing. To enable compression, complete the following steps.

1. Onthe Settings menu, click DICOM.
2. Inthe DICOM Settings dialog box, select the Enable Compression check box.
3. Click OK.

Change the AE title
Media Writer uses a default AE title of MEDIAWRITER. To change the AE title, complete the following steps.

1. Onthe Settings menu, click DICOM.
2. Inthe DICOM Settings dialog box, in the Local AE Title box, type a new AE title.
3. Click OK.

Display series in query results

To display individual series in the query results list, complete the following steps.

1. Onthe Settings menu, click DICOM.
2. Inthe DICOM Settings dialog box, select the Enable Series Query check box.
3. Click OK.

Note: Not all PACS systems support this function.

Display the number of images in each series
To display the number of images in each series in the search results list, complete the following steps.

1. Onthe Settings menu, click DICOM.
2. Inthe DICOM Settings dialog box, select the Display Number of Images check box.
3. Click OK.

Select all studies by default
To select all studies in the search results list by default, complete the following steps.

1. Onthe Settings menu, click DICOM.
2. Inthe DICOM Settings dialog box, select the Select all studies by default check box.
3. Click OK.

Change the query/retrieve port

To change the port that Media Writer uses to query and retrieve DICOM studies, complete the following
steps.

1. Onthe Settings menu, click DICOM.

2. Inthe DICOM Settings dialog box, in the Port box, type or select a port number.

3. Click OK.
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What are auto burn and auto burn profiles?

Auto burn is a function that automatically burns studies after retrieval from modalities. An auto burn profile is a
saved configuration that determines how Media Writer executes the auto burn function. You can create
multiple auto burn profiles for different needs, for example to burn jobs from different ports, or to use different
media or labels. For each auto burn profile you create, Media Writer executes a separate auto burn job.

Delay start of auto burn jobs

By default, auto burn jobs begin immediately after retrieval of studies. To delay the starting of auto burn jobs,
complete the following steps.
1. Onthe Settings menu, click DICOM.

2. Inthe DICOM Settings dialog box, in the Start Burn After list, select a number of seconds to delay.
3. Click OK.

Add an auto burn profile
To add an auto burn profile, complete the following steps.

1. Onthe Settings menu, click DICOM.
2. Inthe DICOM Settings dialog box, under Auto Burn Configuration, click Add.
3. Inthe Auto Burn Profile dialog box, add the following information.
« Profile name. Type a name for the auto burn profile.
« AE title. Type the AE title of the burner to use for auto bumn jobs.
« Port. Type the port number on which Media Writer receives studies for auto burn.
« Media. Select the destination media for auto burn jobs.
« Viewers. Select a viewer program to include on the media.
« Label. Select alabel to print onto the media during auto burn jobs.

Note: The Label list only displays labels that you publish in the Disc Label Configuration dialog box.

« Copies. Select the number of copies to bumn.

« Anonymize studies. Select to anonymize studies.
4. Click OK.
5. Inthe DICOM Settings dialog box, click OK.

Capture raw bytes

This feature is only for advanced troubleshooting that Lexmark service personnel requests. To begin capturing
raw bytes, complete the following step.

o Onthe File menu, click Server > Capture Raw Bytes.
Result A check mark appears next to the Capture Raw Bytes command.

Turn on Debug mode

This feature is only for advanced troubleshooting that Lexmark service personnel requests. To turn on Debug
mode, complete the following step.

e Onthe File menu, click Server > Debug Mode.
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Result A check mark appears next to the Debug command.

Check the server status
To check the status of the server, complete the following step.

« Onthe File menu, click Server > Status.

View server logs
To view logs of server activity, complete the following step.

o Onthe File menu, click Server > Logs.

Restart the server

You can restart the server if it stops unexpectedly. To restart the server, complete the following step.

e Onthe File menu, click Server > Restart.
Log off
You can prevent unwanted access or switch users by logging off. To log off, complete the following step.

« Tolog off the client, on the File menu, click Log off.

Change the language
To change the user interface language, complete the following steps.

1. Onthe Settings menu, click Language.
2. Tochange the language, in the Language dialog box, select a language.

Configure a burner

To burn studies you must configure any burners that you want to use. To configure a burner, complete the
following steps.

On the Settings menu, click Burner.
2. Inthe Burner Configuration dialog box, in the Device Type list, select your type or brand of burner.
3. Inthe Burn Device list, complete one of the following options.

« If you use a built-in disc bumner, select the drive or name of your burner.

« If using an EPSON burner, select the blank option.
4. Click OK.

Set the low disc limit

The low disc limit refers to an amount of free space on the hard disc of the Media Writer server PC. When the
disc reaches the low disc limit, Media Writer begins deleting the oldest studies to make room for new ones. To
set the low disc limit, complete the following steps.

1. Onthe Settings menu, click Burner.

2. Tochange the low disc limit, in the Burner Configuration dialog box, type a number in the Low Disc
Space box.

3. Click OK.
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Configure encryption

You can encrypt studies to prevent viewing them without a password. You configure study encryptionin
advance, and then choose whether or not to use encryption at burn time. To configure encryption, complete

the following steps.
On the Settings menu, click Encryption.
2. Inthe Encryption Settings dialog box, select the Encryption check box.
3. Inthe Encryption list, complete one of the following options.
« Toprevent a user from tuming off encryption, select Force Encryption.
« Toallow a user to turn off encryption, select Selected by Default.
« Toturn off encryption but allow a user to turn it on, select Cleared by Default.
4. UnderPassword, complete one of the following options.
« To automatically create a password, click the Auto option.
« Tocreate your own password, click the Manual option and type a password in the box.

Note: Passwords are case-sensitive, and they can contain any character.
5. Click OK.

Enable display of the password letter

Physicians can enable display of a formatted letter that contains the password to decrypt studies in the
current burn job. Media Writer addresses the letter to the current patient, and the physician can print the letter
from the web browser. After enabling this function, the letter appears automatically at burn time if the user

selects encryption. To format the letter, see Password letter file. To enable the display of the password letter,
complete the following steps.

1. InNotepad, open the mw.configfile.

Note: The default directory for this file is C:\Program Files\PACSGEAR\Media Writer\Client\Config

2. Nexttothe <sHOW ENC MEDIA INFO> tag, change the word NO to YES.
3. Saveand close thefile.

Filterimages from burn and upload jobs

You can create one or more image filters to exclude some images from burn and upload jobs. To create an
image filter, complete the following steps.
On the Settings menu, click Image Filtering.

To enable image filtering, in the Image Filters dialog box, select the Enable check box.
To create a new filter, click New.

A WODN -

In the New Filter dialog box, complete the following substeps.
1. Inthe Group, Element box, type a group and element pair.

Example 0x0008, 0x0060
2. Inthe Value to Match box, type a value for the group and element pair.
Example srR

3. Click OK.
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5. Click OK.

Result Inthe example, Media Writer excludes an image from burn and upload jobs if its DICOM tag
0x0008,0x0060 matches the value SR.

Configure an image exchange service

To upload studies to an image exchange service, you must configure your service in Media Writer. To
configure an image exchange service, complete the following steps.

On the Settings menu, click Image Exchange Service.

To enable image exchange, in the Image Exchange Service dialog box, select the Enable check box.
To add an image exchange service, click Add.

A WODN -

In the Add/Edit Image Exchange Service dialog box, add the following information.
« Service. Select the service provider.

« Alias. Type an alias for the service.

« User name. Type the user name of the account.

« Password. Type the password for the account.

5. Click OK.

6. Inthe Image Exchange Service dialog box, click OK.

About burning and uploading studies

You can burn large studies or multiple copies of studies even if they do not fit onto a single disc. If you use a
single-disc burner, Media Writer automatically spans multiple CDs or DVDs by prompting you to insert new
discs as needed. Media Writer does not span USB media.

An anonymization option is available separately for burning and uploading. You can anonymize studies that
you upload, studies that you burn, or both.

Find and select studies
To find and select studies that you want to burn or upload, complete the following steps.
Prerequisite Configure a DICOM source.

1. Inthe Source list, select a source in which to search for studies.
2. Optional. To narrow the results, complete one or more of the following options.
« Inthe Patient Name box, type one or more of the first characters of a patient’s last name.

« Inthe MRN box, type the exact number, or one or more of the first characters followed by an
asterisk.

« Inthe DOB box, type a date in the format YYYYMMDD.

« Inthe Accession No. box, type the exact number, or one or more of the first characters followed
by an asterisk.

« Inthe Study Date list, select a date range.
3. PressEnter.
Patients matching the search criteria appear in the main screen in gray rows.
4. Inthe search results, click the name of a patient whose studies you want to select.
5. Select the check box next to each study that you want to burn or upload.
6. Optional. If a plus sign appears next to a study, click the plus sign to display series, and then click
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check boxes next to individual series.
7. Optional. To select all studies, right-click a study and click Select All.

Burn selected studies of one patient
To burn selected studies of one patient to media, complete the following steps.

1. Inthe lower part of the main screen, click Burn/Upload.
Note: The button label appears as Bumn if you did not configure an image exchange service.

2. Inthe Confirm Studies: Single Patient dialog box, confirm that the studies in the confirmation list are
correct.

Under Burn Options, select the Burn check box.

To select a destination medium, in the Media list, select a medium.

To print notes onto the disc that are not included in a disc label, in the Notes boxes, type text.
Toinclude a viewer with the studies, in the Viewer list, select a viewer.

To print a label onto the disc, in the Label list, select a label.

N o o AW

Note: The Label list only contains labels that you published in the Disc Label Configuration dialog
box.

8. To select the number of copies, in the Copies list, select a number.
9. Toinclude structured reports in the burn job, select the Include Reports check box.

10. Optional. To execute the burn job before any other jobs on the Current Jobs tab, select the Stat check
box.

11. Optional. To anonymize the studies, select the Anonymize Studies check box.

12. Optional. To encrypt the studies on the media, select the Encryption check box, and then in the
Password box, type a password.

13. Click Confirm.

Upload selected studies
To upload selected studies to an image exchange service, complete the following steps.
Prerequisite Configure an image exchange service.

1. Inthe lower part of the main screen, click Burn/Upload.

2. Inthe Confirm Studies: Single Patient dialog box, confirm that the studies in the confirmation list are
correct.

3. Under Upload Options, complete the following substeps.
1. Select the Upload check box.
2. To specify the destination exchange service, in the Destination list, select a service.

3. Optional. To include comments that appear at the image exchange service when you select the
studies to view, in the Comments field, type comments.

Optional. To anonymize the studies, select the Anonymize Studies check box.
5. At the bottom of the dialog box, click Confirm.
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Select studies to burn for more than one patient

To make studies of more than one patient available to burn at the same time, you must add them to an archive
queue in the main screen. To add studies to the archive queue, complete the following steps.

1. Select the Archive Items tab.

2. Find and select studies of the first patient, and then click Add Item.

3. Repeat this procedure for all patient studies that you want to bumn.
4

Optional. To remove a patient from the list of studies to burn, right-click the patient and click Remove
Patient.

Burn studies of multiple patients
To burn studies of multiple patients, complete the following steps.
Prerequisite Add studies to the Archive Items tab.

1. Click Burn Items.
2. Inthe Confirm Studies: Multiple Patients dialog box, complete the following substeps.
1. To select a destination medium, in the Burn Media list, select a medium.

2. Optional. To print notes onto the disc that are not included in a disc label, in the Notes boxes,
type text.

3. Toinclude a viewer with the studies, in the Viewer list, select a viewer.
4. Toprint alabel onto the disc, in the Label list, select a label.

Note: The Label list only contains labels that you published in the Disc Label Configuration
dialog box.

5. Inthe Copies list, select the number of copies.

6. To execute the burn job before any other jobs on the Current Jobs tab, select the Stat check
box.

7. Toanonymize the studies, select the Anonymize Studies check box.

8. Toencrypt the studies on the media, select the Encryption check box.

9. Toadd apassword that is required to view studies, in the Password box, type a password.
3. Click Confirm.

Resubmit a job
To avoid setting up a job more than once, you can resubmit it. To resubmit a job, complete the following step.

When a burn or upload job succeeds, Media Writer adds a record of the job to the Job History tab. Jobs remain
on this tab for twenty-four hours.

« Onthe Job History tab, right-click the job that you want to resubmit, and then click Resubmit Job.

Retry a failed job

You can retry jobs that failed. If a job fails, it appears in red on the Current Jobs tab with an error message. To
retry a failed job, complete the following step.

« Onthe Current Jobs tab, right-click the job that you want to retry, and then click Retry Job.
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Automatically refresh the Current Jobs tab

Media Writer can automatically refresh the contents of the Current Jobs tab at specified intervals. Jobs do not
appear on the Current Jobs tab until Media Writer refreshes it automatically, or the user refreshes it manually.
To automatically refresh the contents of the Current Jobs tab, complete the following steps.

1. Onthe Settings menu, click Auto Refresh.
2. Inthe Auto Refresh dialog box, select the Auto Refresh check box.
3. Tospecify arefreshinterval, in the Refresh Interval list, select a number of seconds.

Manually refresh the Current Jobs tab

You can manually refresh the Current Jobs tab if Auto Refresh is off, or if you want to refresh before the next
auto refresh. To manually refresh the Current Jobs tab, complete the following step.

« Right-click anywhere on the Current Jobs tab and click Refresh.

Cancel ajob in progress
To cancel ajob in progress, complete the following step.

e Onthe Current Jobstab, right-click the job that you want to cancel and click Cancel Job.

What is a disc label?

A disc label comprises text and images that you can print onto a CD or DVD by using a CD/DVD burner with
a built-in printer. There are two kinds of disc label, simple and advanced.

Simple labels
A simple label includes the following.

« Customizable features

« A background image

« A foreground logo or otherimage
« Uptosevenlines of text

« Patient and study data including the patient name, DOB, MRN, study creation date and time, station ID,
Job ID, exam dates, types, and relevant body parts.

If you do not want patient data to appear on a label, you can anonymize the study or create an advanced label.
You can only create one simple label. Media Writer places the images and text in predetermined locations on
the disc.

Advanced labels

An advanced label includes as many images and text boxes as you want, which you can arrange to create
custom designs. You can create any number of advanced labels, and then select one to print at burn time.

Create a simple label
To create a simple label, complete the following steps.

On the Settings menu, click Disc Label.

2. Inthe Disc Label Configuration dialog box, select the Disc label check box, and then select the
Simple Label option.

3. Tocustomize the label, under Simple Label, complete one or more of the following options.
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« Toadd animage to your label such as alogo, in the Site Logo box, click Browse, navigate to an
image file, and then click Open.

« Toadd a background image, in the Background Image box, click Browse, navigate to an image
file, and then click Open. Note that Media Writer automatically sizes the image so that its width
and height match the diameter of the disc as closely as possible.

« Toadd text to the center of the disc above the hole, in the Site Information boxes, type the text
that you want to add.

« Tochange the color of the site information text, click the corresponding Color button, click a color,
and then click OK.

« Toadd text to the left side of the disc, in the Text Field 1 and Text Field 2 boxes, type text.

« Toapply acolorto the Text Field 1 and Text Field 2 text, click the corresponding Color button.
4. Optional. To preview your label, click Preview.
5. Inthe Disc Label Configuration dialog box, click OK.

Create an advanced label
To create an advanced label, complete the following steps.

1. Onthe Settings menu, click Disc Label.

2. Inthe Disc Label Configuration dialog box, under Advanced Label, complete one of the following
options.

« Tocreate alabel from a template, click New, click a template in the Select Template dialog box,
and then click OK.

« Tocreate alabel that is based on an existing label, in the Label Name list, select a label and then
click Edit.

Change the background of an advanced label

You can change the background of the label to any PNG, JPG, or BMP image. To change the background
image, complete the following steps.

1. Inthe Advanced Label Designer screen, on the toolbar, click the Background Image button.
2. Navigate to the image that you want to use as the background, and then click OK.

Add a foreground image to an advanced label
To add a foreground image to your label, complete the following steps.

In the Advanced Label Designer screen, on the toolbar, click the Image button.
2. Inthe New Image dialog box, complete one or more of the following options.

« Tomake animage available in the New Image dialog box, click the Image File button, navigate to
an image file, and then click Open.

« Toadd animage to yourlabel, click an image in the New Image dialog box, and then click OK.
3. Optional. To move the image, drag it to a new location.
4. Optional. Toresize the image, drag its handles.

Add text to an advanced label
To add text to a label, complete the following steps.

1. Inthe Advanced Label Designer screen, on the toolbar, click the Text Box button.
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A text box appears on the label.
2. Intheright pane, select the Free Text option, and then type text in the box in the right pane.
3. Optional. To move the image, drag it to a new location.
4. Optional. Toresize the image, drag its handles.

Add curved text to an advanced label

You can add text to a label that follows the curvature of the disc. To add curved text, complete the following
steps.
1. Inthe Advanced Label Designer screen, on the toolbar, click the Curved Text button.
A curved text box appears on the label.
2. Intheright pane, select the Free Text option, and then type text in the box in the right pane.
3. Optional. Drag the curved text box to move it along the circumference of the label.

4. Optional. To move the curved text box closer to the center of the label, complete the following
substeps.

1. Click the curved text box.
2. Inthe right pane, drag the Curved Text Position slider to the right.

Format text on an advanced label

You can change the formatting of text in text boxes and curved text boxes. To change the formatting of text,
complete the following step.

« Inthe Advanced Label Designer screen, click a text box or curved text box and use the right pane to
complete one or more of the following options.
« Tojustify the text within the box, click a button under Justification.

« Tochange the font, in the Font list, select a font.

« Tochange the font size, click the Increase Font Size or Decrease Font Size button one or more
times.

« Tochange the text color, in the Font Color list, select a color.
« Toapply bold formatting to the text, click Bold.
« Tomake the text italic, click Italics.

Align text boxes on an advanced label
You can align one or more text boxes to another text box. To align text boxes, complete the following steps.

1. Inthe Advanced Label Designer screen, click the text box to which you want to align other text
boxes.
2. Press and hold the CTRL key and click one or more text boxes to align.

3. Intheright pane, under Text Tools, click the left, right, bottom, top, or center button.

Align text box sizes on an advanced label

You can align the size of one or more text boxes to another text box. To align text box sizes, complete the
following steps.

1. Inthe Advanced Label Designer screen, click the text box to which you want to align other text
boxes.
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2. Press and hold the CTRL key and click one or more text boxes to align.
3. Intheright pane, under Text Tools, click the height, width, or both sizing button.

Set up text box auto-fill on an advanced label

You can automatically fill a text box with information from studies. To auto-fill a text box, complete the
following steps.

1. Inthe Advanced Label Designer screen, click the text box that you want to auto-fill.
2. Intheright pane, select the Auto Fill option and select a field in the list.

The name of the field that you clicked appears in the text box. At burn time, Media Writer substitutes the
field name with the corresponding information from the study.

3. Optional. To print only a portion (substring) of the original information, complete the following substeps.
1. Select the Substring Text check box.

2. Tospecify the first character in the substring, in the Start box, type or select a number.

Example To print only the first three letters of the patient’s name, in the Start box, type or select
0.

3. To specify the number of characters in the substring, in the Length box, type or select a number.
Example In the Length box, type or select 3.
Format dates in auto-filled text boxes
To specify how you want dates to appear in auto-filled text boxes, complete the following step.

« Inthe Label Designer screen, in the right pane, in the Date Format list, select a format.
Preview an advanced label

To preview an advanced label, complete the following step.

« Inthe Label Designer screen, click the preview button.

Refresh a blank field

If any fields in your advanced labels appear blank, you must refresh them so that the field displays correctly.
To refresh a blank field, complete the following steps.

On the Settings menu, click Disc Label.

In the Disc Label Configuration dialog box, under Advanced Label, select a label and click Edit.

On the Advanced Label Designer screen, click the blank field.

In the Error dialog box , click OK.

In the right pane, select the Auto Fill option and select the correct field in the list.

On the toolbar, click the Save button.

N OO b WODN =

To check whether the field appears correctly, click the Preview button.

Save an advanced label
To save an advanced label, complete the following steps.

1. Inthe Advanced Label Designer screen, on the toolbar, click Save Design.
2. Toname your label, in the Design Name box, type a name and click OK.

LX-DOC-MW5.1.9-UH-EN-REVB 16



Media Writer 5.1.9 User Help

3. Onthetoolbar, click the Exit button and click Yes.
4. Inthe Disc Label Configuration dialog box, click OK.

Publish an advanced label

To make an advanced label available to print, you must publish it. To publish an advanced label, complete the
following steps.

On the Settings menu, click Disc Label.

In the Disc Label Configuration dialog box, select the Advanced Label option.

In the Published column, select the check box of the label that you want to publish.

Click OK.
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Configure Media Writer for DICOM structured reports
To configure Media Writer to burn or upload DICOM structured reports, complete the following steps.

1. Onthe Settings menu, click Reports.
2. Inthe Reports Configuration dialog box, select the Enable Reports check box.

3. Optional. To modify how Media Writer processes reports, complete one or more of the following
options.

« Toinclude a splash screen with the report, select the Include Media Splash Screen check box.
« Toinclude reports by default, select the Include Reports by Default check box.
Next Add areport source.

What is a report source?

A report source is a location from which Media Writer can retrieve DICOM structured reports. To make reports
available in Media Writer, you must configure a report source. The following source types are available.

« MITRA_CFIND. A dedicated source type for AFGA Healthcare.

« DICOM_SR. Standard DICOM archives.

« Folder. Locations on local or networked drives.

« Custom. Custom report sources for iSite, AMICAS and Nuance PACS.

Add a MITRA _CFIND report source

To add a MITRA_CFIND report source, complete the following steps.

On the Settings menu, click Reports.
2. Inthe Reports Configuration dialog box, click Add.
3. To configure the source, in the Add/Edit Source dialog box, add the following information.
« Source Type. Select MITRA_CFIND.
« Name. Type a name for the source.
« Port. Type the port number of the source.
4. Click OK.
5. Inthe Reports Configuration dialog box, click OK.
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Add a DICOM_SR report source

To add a DICOM report source, complete the following steps.

On the Settings menu, click Reports.
2. Inthe Reports Configuration dialog box, click Add.
3. Toconfigure the source, in the Add/Edit Source dialog box, add the following information.
« Source Type. Select DICOM_SR.
« Name. Type a name for the source.
« AE Title. Type the AE title of the source.
« IP Address. Type the IP address of the source.
« Port. Type or click an arrow to enter the port number of the source.
4. Click OK.

5. Inthe Reports Configuration dialog box, click OK.

Add a Folder report source

To add a Folder report source, complete the following steps.

1. Onthe Settings menu, click Reports.

2. Inthe Reports Configuration dialog box, Add.

3. To configure the source, in the Add/Edit Source dialog box, add the following information.
« Source Type. Select FOLDER.
« Name. Type a name for the folder.

« Location. Click the navigation button and then navigate to the folder.
4. Click OK.

5. Inthe Reports Configuration dialog box, click OK.

Add a Custom report source

To add a Custom report source, complete the following steps.

On the Settings menu, click Reports.

2. Inthe Reports Configuration dialog box, click Add.

3. Toconfigure the source, in the Add/Edit Source dialog box, add the following information.
o Source Type. Select CUSTOM.
« Name. Type a name for the folder.

« Config File. Click the navigation button and navigate to the configuration file for the source
4. Click OK.
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About decrypting and viewing burned studies

You can view burned studies with a viewer program such as Gear View Basic. However, if you encrypted the
studies at burn time you must decrypt them before viewing. When you decrypt studies, you export them to a
folder to view later. However, if you included Gear View Basic on the media at burn time, you can decrypt and
view the studies immediately.

Decrypt and view studies with Gear View Basic

To decrypt and view studies immediately with Gear View Basic, complete the following steps.

1. Place the medium containing the studies that you want to decrypt and view into the CD-ROM drive or
USB port of the PC.

2. Inthe decryption dialog box, enter the password that you specified when you burned the studies.

3. Click View.
Gear View Basic decrypts the studies and displays them.

Decrypt and export studies with Gear View Basic

To decrypt and export studies with Gear View Basic, complete the following steps.

1. Place the media containing the studies that you want to decrypt and export into the CD-ROM drive or
USB port of the PC.

2. Inthe decryption dialog box, enter the password that you specified when you burned the studies.

3. Click Export.

4. When prompted, click a destination folder and click OK.
Gear View Basic decrypts the studies and copies them into the destination folder.

Decrypt and export studies without Gear View Basic
To decrypt and export studies without Gear View Basic, complete the following steps.
1. Place the medium containing the studies that you want to decrypt and export into the CD-ROM drive or

USB port of the PC.

2. Inthe decryption dialog box, in the Password box, enter the password that you specified when you
burned the studies.

3. Inthe Folder box, click Browse, navigate to a destination folder, and then click OK.
Note: The OsiriX viewer does not support viewing of studies that Media Writer decrypted.

Media Writer decrypts the studies, creates two subfolders within the destination folder, and places the
studies in the last subfolder. For example, if you specify a folder C:\My_Folder, Media Writer creates
the following folder structure: C:\My_FoldenMediaWriterCDs\MWCD _[current time and date]\
[decrypted studies].
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About configuring user access

You can restrict login access to Media Writer by configuring Active Directory users and local users. Media
Writer only allows one type of user per session. When an AD user attempts to log in, Media Writer verifies the
AD user on the AD server before granting access. When a local user attempts to log in, Media Writer verifies
the user against the credentials that you configured.

Add an AD user

To add an AD user, complete the following steps.

On the Settings menu, click Users.

In the Users dialog box, select the Use Active Directory check box.

To identify the host name of the AD server, in the Server box, type the host name.

To identify the domain name of the AD server, in the Domain box, type the domain name.

Optional. To specify backup servers to use when the primary server is unavailable, click the Backup
Servers button, type the host names of one or more backup servers, and then click OK.

6. Toadd users, click Add and complete the following substeps.
1. To specify a user name, in the Add/Edit User dialog box, in the User name box, type a user
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name.
2. Click OK
7. Click OK.

Test an AD user

To test the connection to the Active Directory server, complete the following substeps.

1. Onthe Settings menu, click Users.

2. Inthe Add/Edit Users dialog box, under Active Directory, select the user to test, and then click Test.
3. Type the password, and then click OK.

Note: The test does not apply to backup servers.

Add alocal user
To add a local user, complete the following steps.

On the Settings menu, click Users.

In the Add/Edit Users dialog box, select the Use Local User Login check box.
Under Local Users, click Add.

Optional. To grant administrator rights, in the Add/Edit Users dialog box, select the Admin check box.

AW DN -

5. Toname the user, in the User name box, type a name.

6. Toassign apassword to the user, in the Password and Confirm password boxes, type a password.
7. Click OK.

Select the type of user that can log in

To select the type of user that can log in to Media Writer, complete the following steps.

1. Onthe Settings menu, click Users.
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2. Inthe Add/Edit Users dialog box, complete one of the following options.
« Toselect local users, select the Use Local User Login check box.
« Toselect AD users, select the Use Active Directory check box.

3. Click OK.

Enable auto log off

To automatically log an inactive user off after a specified number of minutes, complete the following steps.

1. Onthe Settings menu, click Users.
2. Inthe Add/Edit Users dialog box, under Auto Log Off, select the Enable check box.

3. Tospecify the time that must elapse with no activity before logging the user off, in the Max idle time
(minutes) box, type a number.

4. Click OK.

Open the user help file
To open the user help file, complete the following step.

e One the Help menu, click User Help.

Change the software license
To change the software license, complete the following step.
Prerequisite Refer to the Installation and Setup Guide to obtain a software license.

1. Onthe Help menu, click About.
2. Inthe License dialog box, click Change.
3. Edit the license key and expiration date and click Close.

Note: You cannot change the system ID.

Display audit logs

Lexmark Software audit logs contain information that you can use to address HIPAA concerns. To display
audit logs, complete the following steps.
On the File menu, click Audit Logs.
To view a message in an audit log, in the Audit Logs dialog box, click a log entry.
To search for an audit log, complete the following substeps.
In the Audit list, select By Patient, By User Name, or Discs Burned Report.
Type or select one or more of the available search criteria, and then click Search.
Optional. To export an audit log, complete the following substeps.
1. Display the audit logs that you want to export, and then click Export.
2. Select a save destination folder.
7. Click OK.

Media Writer saves a log file in CSV format in the destination folder you specified.
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Anonymized DICOM fields

When anonymizing studies, Media Writer makes the DICOM fields in the following table blank, or changes
them to random values.

DICOM tag

Name

(0008,0050)

Accession Number

(0008,0080)

Institution

(0008,0081)

Institution Address

(0008,0090)

Referring Physician's Name

(0008,0092)

Referring Physician's Address

(0008,0094)

Referring Physician's Phone

(0008,0096)

Referring Physician ID Sequence

(0008,1010)

Station Name

(0010,1040)

Department

(0008,1048)

Physician of Record

(0008,1049)

Referring Physician Record ID Sequence

(0008,1050)

Performing Physician's Name

(0010,1060)

Reading Physician's Name

(0008,1070)

Operator

(0010,0010)

Patient Name

(0010,0030)

DOB (convert to YYYYMMO1)

(0010,0032)

Birth Time (set to 12:00)

(0010,1000)

Other Patient IDs

(0010,1002)

Other Patient IDs Sequence

(0008,1005)

Patient's Birth Name

(0008,1040)

Patient's Address
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DICOM tag

Name

(0008,1060)

Patient's Mother's Birth Name

(0008,4000)

Identifying Comments

(0010,1001)

Other Patient Names

(0010,1090)

Medical Record Locator

(0010,2180)

Occupation

(0010,21B0)

Additional Patient History

(0010,4000)

Patient Comments

(0010,2154)

Patient Phone Number

(0032,1031)

Requesting Physician ID Sequence

(0032,1032)

Requesting Physician

(0032,4000)

Study Comments

The following table provides the image compression ratios that Media Writer uses for various modalities.

Compression ratios by modality

Modality Compression Ratio
Default 10:1
NM 0
MR 15:1
Head: 5:1
Brain: 5:1
CT 15:1
Head: 5:1
Brain: 5:1
CR 25:1
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Modality Compression Ratio
DX 25:1
MG 25:1

Password letter file

The cdinfo.txt file contains HTML code that defines the text and formatting of the password letter. The
installation directory for the file is [installpath]\MediaWriter\Client\cdinfo.txt.

Users familiar with HTML can edit this file as needed. Note that you can specify an institution logo in the
<img src="[path to logo file]"..>tag.
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